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Chapter 1: Introduction 

Genotyping Console (GTC) Browser was designed to support copy number and Loss of 
Heterozygosity (LOH) analysis. The visualization of chromosomal aberrations and LOH is 
facilitated by the analysis algorithms within GTC 4.1 which provide graphical results in both a full 
genome-wide karyoview and individual chromosome views. Below are specific details on the two 
graphical views within GTC Browser 1.2. 

 Karyoview: In this view the entire genome is represented visually with chromosomal 
ideograms arranged vertically. Within this view cytobands on each ideogram are represented 
and annotated. Gains and losses are represented by blue and red triangles respectively.  

 Chromosome View: In this view an individually selected chromosome is displayed along with 
the accompanying data graphs and annotation tracks: 

 Segment Report tracks which identify relevant copy number aberrations Log2 ratios for 
all markers of sample array relative to reference. 

 LOH graphical view of homozygous and heterozygous regions. 

 HMM Copy Number State (cnstate) representation. 

 Additional Copy Number tracks are available depending on platform and type of analysis 
performed 

 Ability to link externally to public databases (UCSD, Toronto DGV, and Ensembl). 

 FISH data  

 RefSeq genes. 

 Custom Tracks which allows users to upload regions of interest to display. 

The GTC Browser is installed during the installation of GTC; see the GTC help and manual for 
information on installation and setup. 

The following sections provide information: 

 About this Manual 

 Technical Support. 

About this Manual  

This manual presents information about GTC Browser in the following chapters: 

 Chapter 2: Browser Introduction (page 6): Describes how to open the Browser and 
introduces: 

 Karyoview (page 16) 

 Chromosome view (page 23) 

 Chapter 3: Annotations (page 31): Describes how the annotations are displayed in the 
Chromosome view and how to modify the display of annotations. 

 Chapter 4: Graphs (page 45): Describes how the data is displayed in the Chromosome view 
and how to modify the display of data. 

 Chapter 5: Exporting Data (page 55): Describes how to export images and data. 

 See the GTC 4.1 User Manual for more information about Copy Number and Loss of 
Heterozygosity analysis. 
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Technical Support  

Affymetrix provides technical support to all licensed users via phone or E-mail. To contact 
Affymetrix Technical Support:  

AFFYMETRIX, INC. 

3420 Central Expressway 

Santa Clara, CA 95051 USA 

Tel: 1-888-362-2447 (1-888-DNA-CHIP) 

Fax: 1-408-731-5441 

sales@affymetrix.com 

support@affymetrix.com 

 

AFFYMETRIX UK Ltd., 

Voyager, Mercury Park, 

Wycombe Lane, Wooburn Green, 

High Wycombe HP10 0HH 

United Kingdom 

UK and Others Tel: +44 (0) 1628 552550 

France Tel: 0800919505 

Germany Tel: 01803001334 

Fax: +44 (0) 1628 552585 

saleseurope@affymetrix.com 

supporteurope@affymetrix.com 

 

AFFYMETRIX JAPAN K.K. 

Mita NN Bldg. 16F 

4-1-23 Shiba Minato-ku, 

Tokyo 108-0014 Japan 

Tel. 03-5730-8200 

Fax: 03-5730-8201 

salesjapan@affymetrix.com 

supportjapan@affymetrix.com 

mailto:sales@affymetrix.com
mailto:support@affymetrix.com
mailto:saleseurope@affymetrix.com
mailto:supporteurope@affymetrix.com
mailto:salesjapan@affymetrix.com
mailto:supportjapan@affymetrix.com
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Chapter 2: Browser Introduction 

The GTC Browser 1.2 displays data generated by the following analysis types: 

 Copy Number 

 Loss of Heterozygosity (LOH) 

 Copy Number Segment 

The Browser also displays annotations to help you interpret your results. 

Key features include: 

 Whole genome and chromosome specific views 

 Multi-sample view to facilitate identification of trends in copy number or LOH data 

 Dynamic links to external websites (UCSC, TorontoDGV, ENSEMBL) 

The browser has two different display modes: 

 Karyoview (page 16): see Figure 1. 

 Chromosome view (page 23): see Figure 2. 

 

Figure 1: Browser in Karyoview 
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Figure 2. Browser in Chromosome view 

This section covers the following material: 

 Basic workflow with Browser (below) 

 How to load data into the GTC Browser (page 8) 

 Browser overview (page 15) 

 Karyoview (page 16) 

 Chromosome View (page 23) 

Basic Workflow with Browser 

The GTC Browser is used as part of the GTC Copy Number workflow. The Browser allows you to 
look at copy number and LOH data on a genome-wide scale as part of the following workflow 
(Figure 3):  

1. Generate Copy Number and LOH files in GTC. 

2. Run Segment Reporting Tool to generate Copy Number Segments files. 

3. Review data in the GTC Browser. 

4. Export data for further analysis or view the chromosomal region in a public genome browser. 

Annotations 

Copy Number 
Segments 

Copy Number  

LOH 
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Figure 3. Basic Workflow for generating and viewing Copy Number/LOH data 

Selecting the NetAffx Genome Annotation DB File 

In GTC Browser, genomic assembly version information is contained inside the NetAffx Genomic 
Annotation Database files. 

 Users must download the NetAffx Browser Genome Annotation files from 
Affymetrix.com product pages or support pages. Download the NetAffx Browser 
Genome Annotation file that corresponds to the NetAffx annotation version that was 
used to analyze the data. After the files are downloaded, put them in a local library 
folder (for example, the current GTC library folder).  

Before you can load any data files, you must first load a NetAffx Browser Genome Annotation file. 
These database (DB) files are created by NetAffx and contain information about a particular 
genomic assembly version and annotations (RefSeq, Genomic Variants, FISH Clones) from 
public sources.  

Selecting a Browser Annotation Database File 

If this is the first use of the browser, you will be prompted to download a DB file (Figure 4). After 
you download the DB file, load it in the browser. Each time you start the browser, it will attempt to 
load the database (DB) file you were using in your last session. If the previously used DB file is 
no longer available on your disk, the browser will prompt you to select a DB file.  

Changing to a different DB file will cause the browser to first unload all currently-loaded data files. 
For more details on selecting a different DB file, see page 10. 

1. Click OK in the notice that appears (Figure 4). 

 

 

Open data 
within GTC 4.1 

Whole 
Genome 
View 

Chromosome View 

 

 

Genotyping Console Genotyping Console Browser 

QC 
checkpoint 

Run “Copy 
Number 
and LOH” 
algorithm 

Run “Segment 
Reporting 
Tool” 

Segment 
Report 

QC 
checkpoint 

Export 
graphs 

Export tables 
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Figure 4. Notice to browse for the DB file folder 

2. In the dialog box that appears, navigate to the folder with the DB file and click Open (Figure 
4). 

3. In the next dialog box, select the DB file and click Open (Figure 5). 

 

Figure 5. Select a DB file 

The selected database file is loaded 

After a database file is loaded, the application title bar will display both the NetAffx build 
number and the genome assembly version (Figure 6). 
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Figure 6. Title bar with annotation information 

Changing the Browser Annotation Database File 

Changing the annotation DB file used will automatically change the genome assembly version 
based on the version contained in the file. 

The program will not allow you to load data files generated with a genome assembly version 
which does not match the genome assembly version of the NetAffx annotation database file. The 
currently loaded annotation version is displayed in the title bar of the browser (Figure 6). 

To change the annotation DB file: 

1. From the File menu, select Load NetAffx Browser Annotation Database File (Figure 7). 

A notice appears warning that the currently loaded data files will be unloaded (Figure 8). 

 

Figure 7. Menu commands to load a DB file 
 

 

Figure 8. Notice 

2. Click OK. 

The Choose a NetAffx Annotation DB File dialog box opens (Figure 9). 
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Figure 9. Choose a NetAffx Annotation DB File dialog box 

3. Navigate to the directory where your database files are located and select one of the 
database files.  

The file name uses the format: 

NetAffxGenomicAnnotations.Homo_sapiens.<genome assembly number>.<NetAffx build 
number>.db  

Examples include: 

 NetAffxGenomicAnnotations.Homo_sapiens.hg18.na30.db  

 NetAffxGenomicAnnotations.Homo_sapiens.hg19.na31.db 

 NOTE: The program will not allow you to select a file which does not use this naming 
convention. 

 NOTE: Do not confuse these genome-based annotation database files with array-
specific annotation files. The array-specific files have names which begin with the 
name of an Affymetrix array and end with “.annot.db”.  Example: 
“GenomeWideSNP_6.na24.annot.db”. 

4. Click Open. 

The selected database file is loaded 

After a database file is loaded, the application title bar will display both the NetAffx build 
number and the genome assembly version (Figure 10). 

 

Figure 10. Title bar with annotation information 



 

Affymetrix
®
 GTC Browser User Manual  12 

P/N 702981 Rev 1 

 NOTE: You will only be able to load data files created with the same genome assembly 
version as the version shown in the title bar.  This is because different genome 
assembly versions use different coordinates to refer to the same genomic locations in 
the reference genome assembly. 

 NOTE: You will be allowed to load data files created with a different NetAffx build 
version from the one shown in the title bar, as long as the genome assembly version 
matches.  A warning will be displayed, but you will be allowed to continue. 

How to Load Data into the GTC Browser 

 Upon running Segment Reporting Tool, you are given the option to open the new files 
in the Browser 

See the Genotyping Console 4.1 User Manual for information on: 

 Performing Genotyping analysis 

 Performing Copy Number/LOH analysis 

 Selecting data in the data tree 

To display copy number data in the GTC browser: 

1. In the Genotyping Console data tree, select the copy number data you wish to display (Figure 
11). 

 

Figure 11. Selecting results in the GTC 

2. Right-click on the data and select View Results in Browser from the context-sensitive menu; 
or 

From the Workspace menu, select Copy Number/LOH Results > View Results in 
Browser; or 

In the toolbar, click the View Results in Browser button. 

The Select Copy Number Results dialog box opens (Figure 12). 
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Figure 12. Select Copy Number Results dialog box 

The dialog box displays a list of the Copy Number, LOH, and Copy Number Segments files 
available in the Results set. 

 Note: Not all the file types may be available depending upon the type of array used. 

3. Select the files you wish to view; or 

Click Select All. 

4. Click OK. 

The GTC browser opens and displays the data, along with the default annotation files. 

Loading Additional Data 

To load additional data: 

1. From the File menu, select Open; or 

Click the Open button  in the Browser toolbar. 

The Open dialog box appears (Figure 13). 
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Figure 13. Open dialog box 

2. Browse to the location with the copy number files you want to open. 

3. Select the files. 

4. Click Open. 

The files are displayed in the Copy Number Browser. 
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Overview of Parts 

If the CN Segments data is available, the Browser opens to the Karyoview (Figure 14). 

 

Figure 14. Karyoview (common Browser parts) 

If Copy Number Segments data is not available, or if you click on a chromosome icon, the 
Chromosome view is displayed (Figure 15). 

Menu Bar 

 Tool Bar 

 

Select Chromosome 

 

Status Bar 
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Figure 15. Chromosome view (common browser parts) 

The two views share the following common components: 

 Menu Bar: Access to the functions of the browser. 

 Tool Bar and Chromosome Selector: Quick access to the functions of the Browser/Select 
chromosome for display in Chromosome display. 

 Status Bar: displays: 

 Genomic position of the hairline cursor in Lower left corner 

 Memory in use/available in lower right corner. The maximum memory available is set by 
a start-up script (GenotypingConsoleBrowser.config) and can be modified from 512m to 
higher numbers based on system capacity if necessary by editing that file. 

Karyoview 

The Karyoview (Figure 16) provides an overview of the copy number change regions. In this view 
the entire genome is represented visually with Chromosome ideograms arranged vertically. 
Within this view cytobands on each ideogram are represented and annotated. On this view gains 
and losses are represented by blue and red triangles respectively. 

The Segment Report provides segment-by-segment gain and loss information in a table. 

Clicking on rows in the CN_Segments table or upon regions of the chromosome zooms into the 
Chromosome View of that region 

Menu Bar 

 Tool Bar 

 

Select Chromosome 

 

Status Bar 
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Figure 16: Karyoview 

It displays the copy number region data arranged by genomic position on a chromosome-by-
chromosome basis.  

 Copy Number Gains are indicated by blue triangles and by a semi-transparent blue stripe 
over the chromosome. The stripe is scaled to the exact size of the gain region on the 
chromosome. 

 Copy Number Losses are indicated by red triangles and by a semi-transparent red stripe over 
the chromosome (Figure 17). The stripe is scaled to the exact size of the loss region on the 
chromosome. 

 

Figure 17. Loss and Gain indicators 

For SNP 6.0 Arrays the Segment Report also displays a gender determination made by the 
Segment Reporting Tool for the sample, based on the detected copy number state for the X and 
Y chromosomes. See Appendix D: Gender Call Issues in GTC 4.1 in the Affymetrix® Genotyping 
Console 4.1 User Manual for more information about the CN Segment Report gender call. 

Loss 

 Gain 

 

Segment 
Report 
button 

Segment File list 

Stretch 
Slider 
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To select a file for a different CN Segment Report: 

 Select from the File drop-down list (Figure 18). 

 

Figure 18. Selecting file 

Using the Stretch Slider to Magnify the Vertical Scale 

The Stretch Slider controls the vertical stretch of the Display area (Figure 19). 

 

Figure 19. Vertical stretch enlarged using the slider 

At higher magnifications, more details of the cytobands are displayed in the Karyoview 

Selecting Chromosome or Region for Display 

To select a Chromosome for display: 

 Left-click on the chromosome in the Karyoview display (Figure 20). 
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Figure 20. Left-Clicking on the Chromosome 

The full chromosome is displayed in the Chromosome Display (Figure 21). 

 

Figure 21. Full chromosome displayed 

To select a copy number region for display: 

 Left- click on the copy number segment indicator (Figure 22). 
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Figure 22. Selecting the copy number segment indicator 

A zoomed-in view of the segment is displayed in the Chromosome Display (Figure 23). 

 

Figure 23. Zoomed-in region 

Viewing the Segment Report 

Segment Report displays the information in the Segment file in a table format. 

To open the Segment Report: 

 Click on the View Segment Report button in the Karyoview. 

The Segment Report appears (Figure 24). 
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Figure 24. Segment Report 

This Report is the table version of the output of the Segment Reporting Tool, the cn_segments 
file. Each row represents a particular copy number change segment which deviates from the 
expected normal. 

 This table can be used to “drive” the Browser by allowing users to “hop” from Copy 
Number change segment to segment. 

 Data can be sorted by clicking on column headers. You can re-sort the row order in 
the results by one or more criteria. Click on the column header to set the primary sort 
column. Control-click on additional column headers to set secondary sorting criteria. 

 Columns can be moved by clicking, dragging and dropping them by their headers 

Sample File name. 

Copy Number State CN state of the last marker in a segment as estimated by the HMM. 

Loss/Gain Whether the Copy number change is a decrease or increase from the 
expected normal value. 

Chr (Chromosome) Chromosome where the segment is located. 

Cytoband_Start_Pos The Chromosome’s cytoband within which a Copy Number change 
segment begins. 

Cytoband_End_Pos The Chromosome’s cytoband within which a Copy Number change 
segment ends. 

Size (kb) Size of the segment of Copy Number change. 

#Markers Number of SNPs+CNV markers within the segment. 

Avg_DistBetweenMarkers(kb) Length of segment divided by number of markers encompassed by that 
segment. 
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%CNV_Overlap Percentage of markers in a segment which overlap the boundaries of a 
known CNV. 

Start_Linear_Pos Base pair position on the Chromosome at which the first marker in the 
segment begins (going from top of the p-arm to the bottom of the q-arm 
of the chromosome). 

End_Linear_Position Base pair position on the Chromosome at which the last marker in the 
segment begins (going from top of the p-arm to the bottom of the q-arm 
of the chromosome). 

Start_Marker Name of the first SNP or CN marker of a Copy Number change 
segment. 

End_Marker Name of the last SNP or CN marker of a Copy Number change 
segment. 

CNV_Annotation Information from the Toronto Database of Genomic Variants about the 
CNV variants which overlap the Copy Number change segment. 

You can export data for use in other applications. 

To export to TSV format: 

1. From the Tools menu, select Export All to TSV…; or 

Click the TSV button  in the toolbar. 

The Save dialog box opens (Figure 25). 
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Figure 25. Save dialog box. 

2. Select a save location and enter a file name for the TSV file. 

3. Click Save. 

The TSV file is saved in the specified location. 

To copy data to the clipboard: 

1. Select the data you want to copy in the table. 

2. From the Tools menu, select Copy Selections; or 

Click the Copy Selections button  in the toolbar, or use Control+C. 

The selected data is copied to the clipboard and can be pasted into other files. 

Chromosome View 

The Chromosome view (Figure 26) enables you to look in detail at the available data and 
annotations for copy number and LOH. 

The GTC Browser can work with two distinct types of data:  

 annotations 

Annotations indicate the known or suspected locations of features, such as mRNA's, exons, 
FISH clones, structural variants, and so forth. Annotation data can be loaded from files. 

For more information about annotations, see Chapter 3: Annotations (page 31). 
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 graphs 

Graphs indicate scores or other numeric values as a function of genomic position. Graphs are 
generally displayed as some form of plot (x,y-plot, bar plot, etc.). The results from GeneChip

®
 

tiling arrays and from chromosome copy number analysis are generally represented as 
graphs. Simple graphs represent values for individual genomic positions. Graph data is 
generally loaded from files. 

For more information about graphs, see  

Chapter 4: Graphs (page 45). 

 

Figure 26. Parts of the GTC Browser (Chromosome view) 

The Chromosome view has the following components: 

 Chromosome selection bar: selects chromosome for display. 

 Chromosome view selection: selects files, annotation types, and graph types for display. 

 Display Area: location on screen where the data representations and annotations are 
displayed. 

Selecting Files and Chromosomes for Display 

To select a different Chromosome for display: 

 Select from the Chromosome Selection bar (Figure 27), or 

From the View menu, select Display Chromosome. 

 You can also type the chromosome and coordinates into the Range box below the 
Chromosome Selection bar in the format “chr12: 10000-20000”. 

Display Area 
(Chromosome View) 

Select Chromosome 

Chromosome 
View Selection 
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Figure 27. Chromosome selection bar 

To select files for display: 

 Select or deselect from the Files list on the left side of the screen (Figure 28). 

 

Figure 28. Files list 

Selecting annotations is described in Selecting Annotations for Display. 

Selecting graphs is described in Selecting graph types for Display. 

Display Area 

The annotations and graphs are displayed in the Display area (Figure 29). 
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Figure 29. Chromosome View, display area controls 

The display area has the following features and controls: 

Chromosome 
Coordinates range 
box 

Displays and selects the range of genome position coordinates displayed in the 
display box. 

Chromosome 
Coordinates scale 

Shows the position along the genome. 

Zoom Slider Controls the horizontal zoom and the area of the chromosome displayed. 

Stretch Slider Controls the vertical stretch of the Display area. 

Scroll bars Used to select the area displayed after zooming or stretching the vertical or 
horizontal scale. 

Navigation in the Chromosome view 

This section describes how to manually navigate around in the Chromosome display to see 
annotations on the genomes and chromosomes you have loaded and how to zoom-in on areas of 
interest. Many of these navigation functions have “shortcut” keys. Hold your mouse over the 
button to see the tool-tip telling you what the shortcut key is for each button. For example, zoom 
in vertically with “control + shift + right arrow”. 

Zooming and scrolling horizontally 

The horizontal zoom slider (Figure 30) is located along the top edge of the viewer.  

Zoom Slider 

Vertical 
scroll 
bars 

Chromosome Coordinate 
Range Box 

Chromosome Coordinates Scale 

Horizontal scroll bars 

Stretch 
Slider 
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Figure 30. Horizontal Zoom Slider (with Chromosome Coordinate range box and Restore 
Original button) 

To zoom in, move the zoom slider to the right. To zoom out, move the zoom slider to the left. 

The hairline marks the focus of horizontal zooming. Click in any empty position in the view to 
reset the hairline position and thus reset the center of zooming. 

 

Figure 31. Horizontal Scroll controls 

When you are zoomed in, you can scroll through the view in several ways:  

 Use the horizontal scroll box slider (Figure 31) at the bottom of the viewer panel to scroll 
along the chromosome. Slider size and speed of movement will vary according to the current 
zoom level. 

 Click the Horizontal step buttons to move in larger increments. 

 Click in the scroll bar trough on either side of the slider to move it in the direction of your click.  

 For finest precision when zoomed in, click the arrows at the ends of the scroll bar.  

When you are zoomed all the way out (the horizontal zoom control slider is at the far left), you are 
already viewing the entire range of the loaded data (entire chromosome) and the scroll box slider 
is not available. 

Zooming and scrolling vertically 

Zooming and scrolling vertically are similar to zooming and scrolling horizontally. Zooming 
vertically is especially useful for viewing annotation types with many rows of annotations. To learn 
about collapsing and expanding annotations in the display, see Expanding and Compressing . 

The vertical zoom slider is located immediately to the left of the main view. To zoom the view 
vertically, drag the vertical slider down.  

After expanding vertically, use the vertical scrollbar on the right of the display to view different 
annotation rows.  

Going to a Specific Coordinate 

To go to a specific coordinate or coordinate range, use the coordinate range box (Figure 32) 
located at the left-hand side of the horizontal zoom slider, which is directly above the main view. 

 

Figure 32. Coordinate Range Box 

Horizontal 
Step 
buttons 

Precision button 

Scroll Slider 

Precision button 

Scale slider Zoom In Zoom Out 

Restore 
original 
display 
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The range box displays the current coordinate range. But you can also type a new location into 
the box to go there quickly. Enter the desired location in any one of these formats then press the 
<Enter> key: 

 “chromosome : start - end”: sets the view to the given start and end coordinates on the 
given chromosome. This is the same format used by the UCSC genome browser, so you can 
easily copy coordinates from that application. Example: “chr3:100000-200000”. 

 “start : end” or “start - end”: sets the view to the given start and end coordinates of the 
current chromosome. 

 “chromosome : start + width” or “start + width”: sets the view to the given start coordinate 
and sets the zoom level such that the given width of coordinates is visible. 

 “position”: moves the hairline to the given position. Example: “100,000”. If possible at the 
current zoom level, the view will be scrolled such that the given position is in the center of the 
view. 

If the specified chromosome or position does not exist in the currently loaded genome, an error 
message will be shown. 

Viewing the Selected Region in another Browser 

You can view the region selected in the Display area at one of the following public sites: 

 UCSC 

 Ensembl 

 Toronto DGV 

To view the region at a public site: 

1. Adjust settings as described above so that the entire region of interest is visible in the Display 
Area (Figure 33). 
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Figure 33. Selected region in Display area 

2. From the View menu, select View Region at [site name]. 

A web browser opens with the public site displaying the chromosome region selected in the 
GTC Browser (Figure 34). 
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Figure 34. Region displayed in UCSC Genome Browser 
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Chapter 3: Annotations 

Annotations indicate the known or suspected locations of features, such as mRNA's, exons, 
promoter regions, pseudogenes, genomic variants, and FISH/BAC clones. They provide 
information you can use to evaluate your results. 

This section discusses: 

 Annotation Types (below) 

 Selecting Annotations for Display (page 32) 

 Loading Other Annotations (page 33) 

 Expanding and Compressing Annotations (page 33) 

 Learning More about Annotations (page 34) 

Annotation Types 

The GTC 4.1 browser can display the following annotation types: 

 Fishclones 

 Genomic Variants 

 RefSeq 

 Copy Number Segment data generated by GTC. 

 Some annotation types may not be available in all annotation builds. 

Fishclones 

This track shows the location of fluorescent in situ hybridization (FISH)-mapped clones along the 
sequence. The locations of these clones were contributed as a part of the BAC Consortium paper 
Cheung, V.G. et al. (2001). More information about the BAC clones, including how they may be 
obtained, can be found at the Human BAC Resource and the Clone Registry web sites hosted by 
NCBI and at http://genome.ucsc.edu/cgi-bin/hgTrackUi?g=fishClones.  

 The Fishclones track is not yet available for the current NetAffx browser Genome 
Annotation file (NetAffxGenomicAnnotations.Homo_sapiens.hg19.na31.db). 

http://www.ncbi.nlm.nih.gov/genome/cyto/hbrc.shtml
http://www.ncbi.nlm.nih.gov/genome/clone/index.html
http://www.ncbi.nlm.nih.gov/
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Figure 35. GTC browser without Fishclones track 

 

Genomic Variants 

This annotation shows regions detected as putative copy number polymorphisms and sites of 
detected intermediate-sized structural variation. They were determined by various methods; more 
information can be found at: http://projects.tcag.ca/variation/ 

The term "variant" is used to describe each Copy Number polymorphic or other structural variant 
region as reported in a published study. Each variant is assigned a unique identifier, which is 
static and does not change over time. 

RefSeq 

Annotations taken originally from NCBI RefSeq database, as housed on the UCSC Genome 
Bioinformatics site, with information on mRNA's, exons, promoter regions, pseudogenes. See: 

 http://www.ncbi.nlm.nih.gov/RefSeq/  

 http://genome.ucsc.edu/index.html  

The annotations were updated to match the NA26 annotations used by NetAffx for release. For 
additional information, check the Affymetrix.com support page: 
http://www.affymetrix.com/support/help/releasedocs/netaffx_release_26.affx 

Copy Number Segment Data 

This annotation track shows segments on the chromosome of copy number variation as detected 
by the Copy Number Segment Reporting Tool in Genotyping Console 4.1. 

Selecting Annotations for Display 

To select annotations for display: 

 Select or deselect from the Annotations Types list on the left side of the screen (Figure 36). 

http://www.ncbi.nlm.nih.gov/RefSeq/
http://genome.ucsc.edu/index.html
http://www.affymetrix.com/support/help/releasedocs/netaffx_release_26.affx
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Figure 36. Annotation Types list 

Loading other annotations 

You can load annotation data of your own choice in BED format. The BED format is a simple tab-
separated values file with three required columns containing coordinates and nine optional ones. 

BED files are required to be named with the extension “.bed”. 

Refer to http://genome.ucsc.edu/FAQ/FAQformat for details of the format. GTC Browser 1.2 
supports all the variations of the BED format listed there. 

Expanding and Compressing Annotations 

For tracks containing multiple rows of annotations, collapsing tracks consolidates all rows within a 
track into 2 rows (Figure 37). Any annotations after the first one will be drawn together in the 
second row. 

When there are multiple annotations of one type at the same coordinate, the separate 
annotations will be shown on separate rows. 

Collapsing tracks is useful if you don't need to see all the details. But be aware that in collapsed 
tracks larger annotations may obscure smaller ones; annotations with introns may be obscured 
by annotations that don’t show the intron. 

 

Figure 37. Collapsing and expanding annotations 

Expanded 
annotations 

Collapsed 
annotations 

http://genome.ucsc.edu/FAQ/FAQformat
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To collapse or expand annotations: 

 From the View menu, select: 

 Collapse All Annotations 

 Expand All Annotations 

All strands of the annotations will be affected. 

Learning More about Annotations 

You can learn more about annotations using the: 

 Selection Details table (below) 

 List View table (page 41) 

Selection Details 

The Selection Details table displays information about a selected annotation: 

To learn more about an annotation:  

1. Right-click on the item in the Display area. 

The context-sensitive menu appears (Figure 38). 

 

Figure 38. Context menu for a CN-Segments region 

2. Select Show Selection Details.  

The Selection Details dialog box appears (Figure 39). 
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Figure 39. Selection Details for CN_Segment 

The information displayed differs depending upon what type of annotation is being selected: 

 Copy Number Segment 

 FISHclones  

 Genomic Variant 

 RefSeq 

To transpose the data in the display: 

 From the Tools menu, select Transpose Table. 

The data is displayed in a single row (Figure 40). 
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Figure 40. Transposed table 

To export to TSV format: 

1. From the Tools menu, select Export All to TSV…; or 

Click the TSV button in the toolbar. 

The Save dialog box opens (Figure 41). 



 

Affymetrix
®
 GTC Browser User Manual  37 

P/N 702981 Rev 1 

 

Figure 41. Save dialog box. 

2. Select a save location and enter a file name for the TSV file. 

3. Click Save.  

If you do not add a “.tsv” extension to the file name, this will be done the first time the Save 
button is clicked; the Save button must then be clicked again to save the .tsv file. 

The TSV file is saved in the specified location. 

Copy Number Segment Details 

When you select a segment in the Copy Number Segment track, the Selection Details table 
(Figure 42) displays information on a particular copy number change segment. It displays the 
same information as in the Segment Report. 
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Fishclones Details 

 

Figure 42. Selection Details for fishClones annotation 

The following information is displayed for fishClones annotations (Figure 42): 

Property Field descriptor for a row in the table. 

ID Name of the fluorescent in situ hybridization (FISH)-mapped clone. 

Start Physical position where FISH clone begins. 

End Physical position where FISH clone ends. 

Length Length of FISH clone in bp. 

Method Source file for table information. 
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Genomic Variant Details 

 

Figure 43. Selection Details for Genomic Variants annotation 

The following information is displayed for Genomic Variants annotations (Figure 43). 

Property Field descriptor for a row in the table. 

ID Variant’s unique identifier. 

Start Position of base pair assigned as start of variant. 

End Position of base pair assigned as end of variant. 

Length Length of variant in base pairs. 

Landmark Coordinates or genomic clone. 

Variationtype CNV, insertion, deletion, inversion or translocation. 

Reference Publication cited for this variant. 

PubMedID PubMedID for the cited publication. 

Method/platform Molecular techniques or other evidence used to identify 
variant. 

Gain Absolute number or frequency of gains of this variant 
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among cited study population. 

Loss Absolute number or frequency of losses of this variant 
among cited study population. 

TotalGainLossInv Absolute number or frequency of all 
gains+losses+inversions among cited study population. 

SampleSize Number of individuals in the study population of the cited 
publication. 

RefSeq Details 

 

Figure 44. Selection Details for RefSeq annotation 

The following information is displayed for RefSeq annotations Figure 44): 

Property  

id Refseq nucleotide Accession Number for gene. 

Start Nucleotide position in base pairs where gene starts. 
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End Nucleotide position in base pairs where gene ends. 

Length Length of selected gene or gene region (exon, promoter, etc.). 

Type Indicates which type of annotation you have selected. Always equals “refseq” for 
items in Refseq track. 

Gene name Gene Symbol used by Refseq. 

Seq id Chromosome name. 

Cds min Coding sequence’s smallest numerically ordered base pair. 

Forward On the + strand; value will be true or false. 

Cds max Coding sequence’s largest numerically ordered base pair. 

List View 

The List View table (Figure 45) can also be displayed when you right-click on an annotation in the 
Chromosome View: 

 

Figure 45. List View table 

This table gives the positional information about a selected Browser object, allows export of this 
information as a BED file which can be loaded into the browser as a track 

It displays the following information: 

Chromosome The chromosome the annotation is on. 

Min Minimum coordinate on the chromosome. 

Max Maximum coordinate on the chromosome. 

Strand Which strand of the DNA the annotation is on. 

ID The annotation ID, if any. For data from the CN_SEGMENTS 
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files, an ID is constructed from the location coordinates . 

Type Identifies the file or annotation type for the annotation. 

To export to TSV format: 

1. From the Tools menu, select Export All to TSV…; or 

Click the TSV button in the toolbar. 

The Save dialog box opens (Figure 46). 

 

Figure 46. Save dialog box. 

2. Select a save location and enter a file name for the TSV file. 

3. Click Save. 

If you do not add a “.tsv” extension to the file name, this will be done the first time the Save 
button is clicked; the Save button must then be clicked again to save the .tsv file. 

The TSV file is saved in the specified location. 

To export to BED format: 

1. From the Tools menu, select Export All to BED…; or 

Click the BED button  in the toolbar. 

The Save dialog box opens. 

2. Select a save location and enter a file name for the BED file. 
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3. Click Save. 

If you do not add a “.bed” extension to the file name, this will be done the first time the Save 
button is clicked; the Save button must then be clicked again to save the .bed file. 

The BED file is saved in the specified location. 

To copy data to the clipboard: 

1. Select the data you want to copy in the table. 

2. From the Tools menu, select Copy Selections; or 

Click the Copy Selections button  in the toolbar. 

The selected data is copied to the clipboard and can be pasted into other files. 

To search the annotations: 

1. From the Tools menu, select Find Annotations…; or 

Click the Find Annotations button  in the toolbar. 

The Search dialog box opens (Figure 47). 

 

Figure 47. Search dialog box 

The Search dialog box allows you to search the annotation files for all or part of the names of 
an annotation. You can search one or many annotation types for an ID. 

2. Select the Find Annotations By option you wish to use and enter a value, if necessary: 

All IDs Return all annotations that meet the Chromosome and Annotation type 
selections. 
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Exact ID Return annotations that match the entered value exactly. 

ID starts with  Return annotations that begin with the entered value. 

ID between  IDs alphabetically between the given values. Example: “hoxa” to “hoxc” 
would give all homeobox genes with names starting with “hoxa” and 
“hoxb”, but not “hoxc” or “hoxd”. 

Regular Expression Allows for wildcard ID searches. A single wild character is represented by 
a period. Multiple wild characters in a row by period-star: “.*”  

3. Limit the results returned by chromosome location: 

All Chromosomes Return matches on all chromosomes. 

Chromosome number Return matches only on selected chromosome. 

4. Select the annotation file to search from the drop-down list; or 

Select <ALL> to search all annotation files. 

Click Reset to clear the entries; or  

5. Click OK to perform the search.  

The List View displays a list of annotations that match the search terms (Figure 48). 

 

Figure 48. List View 

Click in the row for an annotation to display that segment of the genome in the Browser. 
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Chapter 4: Graphs 

Graphs indicate scores or other numeric values as a function of genomic position. Graphs are 
generally displayed as some form of plot (x,y-plot, bar plot, etc.). The results from GeneChip 
mapping arrays and from chromosome copy number analysis are generally represented as 
graphs. Simple graphs represent values for individual genomic positions. Interval graphs 
represent values for ranges of genomic positions. 

There are two main features of the graphical view: 

 In all graphical views, the X-axis corresponds to a physical position along the chromosome, 
and the Y-axis is the value of the metric displayed (except for heatmaps, where the color 
indicates the value of the metric). 

 The graph name (displayed above each graph) indicates the *.cnt or *.cnchp or *.lohchp 
filename followed by the metric graphed. For example, SK-BR-
3_NSP_CN.brlmm.CN:Log2Ratio indicates that the Log2Ratio metric of the sample file 
SK-BR-3_NSP_CN.brlmm.CN.CNT is displayed in the first chart. 

 

Figure 49. Loss of heterozygosity (LOH) graph with graph handle selected 

 

Figure 50. Copy Number graph (zoomed in) 

Click on the Graph handle at the left end of the graph bar (Figure 49) to: 

 Drag the graph to a new position. 

 Select the graph for modification (see Changing graph appearance). 

This section explains: 

 How to select graphs types for display (page 46) 

 Changing graph appearance (page 50) 

Graph Handle (not 
selected) 

 

File Name 

 

Graph type and y-axis scale 

 

Graph Handle (selected) 

File Name Graph type and y-axis scale 
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Selecting graph types for Display 

To select files for display: 

 Select or deselect from the Graph Types list on the left side of the screen (Figure 51). 

 

Figure 51. Graph Types list 

The types of graphs available differ, depending upon the type of array and the type of analysis 
performed. 

Different types of data can be displayed for: 

 100K500K array data 

 SNP 6.0 array data 

Types of Data Displayed for 100K/500K 

Copy Number Graphs 

 Values in the chart below that are labeled paired analysis only require that the check 
box next to Generate Allele-Specific Copy Number (Advanced Options page) be 
selected. 
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Figure 52. Copy Number Graphs for 100K/500K data 

The following types of copy number data (Figure 52) can be displayed: 

Data type Definition 

chipnum 1 or 2. Only for the 100K or 500K two-chip SNP assay. 

CNState HMM copy number state. 

CNStateMax HMM copy number state of the allele with the higher signal intensity (paired 
analysis only). 

CNStateMin HMM copy number state of the allele with the lower signal intensity (paired 
analysis only). 

HmmMedianLog2Ratio Median Log2Ratio value of all contiguous SNPs in the given HMM copy number 
state segment. 

HmmMedianLog2RatioMax Median Log2 Ratio value of all the contiguous SNPs in the given HMM copy 
number state segment of the allele with the higher signal intensity (paired analysis 
only). 

HmmMedianLog2RatioMin Median Log2 ratio value of all the contiguous SNPs in the given HMM copy 
number state segment of the allele with the lower signal intensity (paired analysis 
only). 



 

Affymetrix
®
 GTC Browser User Manual  48 

P/N 702981 Rev 1 

Data type Definition 

Log2Ratio Smoothed Log2Ratio value. 

Log2RatioMax Smoothed Log2 ratio value for the allele with the higher signal intensity (paired 
analysis only). 

Log2RatioMin Smoothed Log2 ratio value for the allele with the lower signal intensity (paired 
analysis only). 

NegLog10PValue Negative Log10 p-value indicating how different the median Log2Ratio of the HMM 
state is from the normal state (CN State 2) for that particular sample. 

NegLog10PValueMax Negative Log10 p-value indicating how different the median Log2 ratio of the HMM 
state of the allele with the higher signal intensity is from the normal state (CN State 
2) for that particular sample (paired analysis only). 

NegLog10PValueMin Negative Log10 p-value indicating how different the median Log2 ratio of the HMM 
state of the allele with the lower signal intensity is from the normal state (CN State 
2) for that particular sample (paired analysis only). 

LOH Data Displayed 

 

Figure 53. LOH graphs for 100K/500K data 

The following types of LOH data (Figure 53) can be displayed: 

Data Type Definition 

Call Genotype call for the tumor/test sample. 

chipnum 1 or 2. Only for the 100K or 500K two-chip SNP assay. 
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Data Type Definition 

LOHProb Likelihood that a SNP is in LOH state (closer to 1 indicates a stronger likelihood of LOH). 

LOHState 1 = LOH and 0 = Retention. 

RefCall Genotype call for the paired reference sample (paired analysis only). 

RetProb Likelihood that an SNP is in Retention state (closer to 1 indicates a strong likelihood of 
Retention). 

Types of data displayed for SNP 6.0 

 

Figure 54. Graphs for SNP 6.0 data 

The following types of data (Figure 54) can be displayed for SNP 6.0. 

Data type Definition 

AlleleDifference Difference of A signal and B signal each standardized with respect to their 
median values in the reference. 

CNState HMM copy number state. 

Log2Ratio Smoothed Log2 ratio value. 

LOH LOH State; 1=LOH, 0=Retention. 

smoothsignal Smoothed log2 ratios or smoothed log2 ratios calibrated to Copy Number and 
anti-logged (depending on the options setting during copy number/LOH analysis) 



 

Affymetrix
®
 GTC Browser User Manual  50 

P/N 702981 Rev 1 

Changing graph appearance 

You can modify many properties of the graphs, including: 

 The height of the graph 

 The style used to display the data 

 The color of the graph 

 The scale of the graph 

Settings and adjustments that are specific for graphs can be made using the Graph Properties 
dialog box. 

To change the settings for selected graphs:  

1. Select the graph(s) to change by doing one of the following:  

 To change a single graph, click the colored bar at the left side of a graph (the graph 
handle) or the track label to select it.  

 Shift-click to select additional graphs. 

2. Right-click on the graph handle and choose Properties… from the menu (Figure 55).  

 

Figure 55. Selecting a graph 

The Graph Properties dialog box opens (Figure 56).  

 

Figure 56. Graph Properties dialog box 

 You can also open the Graph Properties dialog box by clicking the Properties button in 
the toolbar. 

3. Make changes to the graph settings by typing in new values or by operating sliders in the 
Graph Adjuster panel. For details, see: 

 Change the height of a graph 
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 Change graph style 

 Change graph color 

 Change scale 

Any changes you make to the values in the Graph Properties dialog box will apply to all 
currently selected graphs. 

To change the settings for all graphs: 

1. Click the Properties button in the Browser toolbar. 

The Graph Properties dialog box opens. 

2. From the Graphs menu, select Select All Graphs; or 

Click the Select All Graphs button in the dialog box toolbar.  

Change the height of a graph 

There are two ways to change the vertical height of a graph:  

 Select the graph(s) you want to change by (shift+)clicking on their handles, press the Graph 
Properties icon, then drag the Height slide bar in the Graph Adjuster tab. 

 Use the Stretch Slider on the left side of the Display to stretch all Graphs and Annotations 
simultaneously in the vertical direction 

Change graph style 

Graphs can be shown in various representational styles. The type of graph that is most 
appropriate depends on the type of question being asked about the data. For example, when 
comparing trends and patterns, it is very useful to use the line graph display method. The number 
of expression intervals being shown also can affect the graph display choice. The user is 
encouraged to experiment with the different display types to find out which method works best for 
specific purposes and at specific zoom in magnifications. 

To change the graph style: 

1. SHIFT + Click the colored bar at the left end of the graph. 

2. Click the Graph Properties tab. 

3. In the Style section choose one of the options. 

 

The following graph styles are available in GTC Browser:  

 Bar (Figure 57)– Individual values are shown as vertical bars that are one base wide for 
position graphs and of variable width for interval graphs. 
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Figure 57. Bar 

 Line (Figure 58) – Subsequent values are linked with a line. Even if the input file was not 
sorted, the values will be connected in order along the genomic coordinate axis. 

 

Figure 58. Line 

 Points (Figure 59) – Shows a single dot for each data value. For interval graphs, horizontal 
lines will be connected to the start and end points. 

 

Figure 59. Points 

 Big dots (Figure 60) – Shows a single big dot for each data value. 

 

Figure 60. Big dots 

 Min/Max/Avg (Figure 61) – This style is especially useful for showing very densely populated 
graphs with data points for large numbers of positions. 
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Figure 61. Min/Max/Average 

When GTC Browser is zoomed all the way in, the display is equivalent to the Line style. 
When zooming out, GTC Browser starts to summarize values. When the scale of the display 
reaches the point where individual x-values are associated with multiple score values, GTC 
Browser picks the maximum and minimum values and draws a vertical bar between them. In 
addition, GTC Browser draws lines through the average of all the data points represented at 
each x value. 

 Stairstep (Figure 62) – Similar to the bar graph style, except that bar widths along the 
horizontal axis are stair-stepped.  

 

Figure 62. Stairstep 

For example, if position 100 has a value of 50 and position 200 has a value of 75 and there 
are no values in between, then GTC BROWSER will draw a bar of height 50 that starts at 
position 100 and stops at position 200. Then, at position 200, GTC BROWSER will draw a 
new bar of height 75 that terminates at the next location with a value. 

This style is particularly useful for viewing .egr and .sgr files, ESTs, or other high-density data. 

 Heat map (Figure 63) – Instead of showing relative intensity via the height of the line at each 
pixel or coordinate as in most other graph styles, a heat map shows expression levels via 
color or brightness of the line at each pixel or coordinate. This graph style is useful if you 
want areas of greater values to jump out at you. If a graph does not render or is hard to see, 
adjust the visible bounds of the graph until features are readily visible. Several heat map 
color schemes are available to choose from. 

 

Figure 63. Heat map 
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Change graph color 

To change graph color: 

 Click the graph handle on the left end of the graph to select the graph. 

 Click the Graph Properties button. In the Style section, click the Color button. 

 Choose the desired color, and then click OK. 

For graphs in the heat map style, the chosen color will only be used on graph labels and handles. 
The data colors come from the chosen heat map. 

Change scale 

Changing the visible bounds involves changing the scale of the graph by setting the maximum 
and minimum values to be displayed.  

To set these visible bounds, use the Y-axis scale section of the Graph Properties dialog: 

 Select the graph(s) to change: Click the graph handle at the left end of each graph to change. 
(Shift-click to select more than one.). 

 Click the Graph Properties button. 

 Adjust the visible graph bounds: 

 

To set specific minimum and maximum values, use the sliders, or type in values to the boxes, 
these values will be applied to each selected graph. You are free to set maximum and minimum 
values that cover a range smaller or larger than the actual range of your data. 
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Chapter 5: Exporting Data 

GTC Copy Number Browser can export: 

 Images for use in other documentation 

 Data from graphs 

Other data export functions are described in the sections of the different information boxes 
(Selection Details, List View, Segment Report). 

Exporting Images 

Graph images can be exported to share with other researchers in the following formats: 

 PDF 

 PNG: can be inserted in other documentation. 

 You can export graphics from both Karyoview and Chromosome view. 

To export as a PNG graphic: 

1. Set up the display the way you want it. 

2. From the Graphs menu, select Export PNG. 

The Save dialog box opens (Figure 64). 

 

Figure 64. Save dialog box for PNG file 
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3. Use the dialog box controls to select a location and enter a file name. 

4. Click Save. 

If you do not add a “.png” extension to the file name, this will be done the first time the Save 
button is clicked; the Save button must then be clicked again to save the .png file. 

A graphic in PNG format is saved. 

You can send the graphic to another researcher or use it in a document. 

To export as a PDF file: 

1. Set up the display the way you want it. 

2. From the View menu, select Export PDF. 

The Save dialog box opens. 

3. Use the dialog box controls to select a location and enter a file name. 

4. Click Save. 

If you do not add a “.pdf” extension to the file name, this will be done the first time the Save 
button is clicked; the Save button must then be clicked again to save the .pdf file. 

A PDF file of the graphic saved. 

You can send the graphic to another researcher. 

Exporting Graph Data 

 You can export graph data only from the Chromosome view. 

You can export graph data in wiggle (WIG) format for viewing in other genome browsers.  

 The wiggle (WIG) format allows display of continuous-valued data in a track format. For 
more information, see www.genome.ucsc.edu. 

To export graph data: 

1. From the Graph menu, select Export Displayed Graphs. 

The Save dialog box opens. 

2. Select the File name and location where you want the file to be saved. 

3. Save the file. 

If you do not add a “.wig” extension to the file name, this will be done the first time the Save 
button is clicked; the Save button must then be clicked again to save the .wig file. 

 

 

 

http://www.genome.ucsc.edu/
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